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1. X – модели неоднородностей 
1.1. Особенности X - моделей 
 

X – модели являются моделями неоднородностей, полученными на основе электромаг-
нитного моделирования. Эти модели объединяют возможности электромагнитного (высокая 
точность) и линейного (высокое быстродействие, возможность проведения настройки, оптими-
зации и статистического анализа) моделирования. Имена всех X – моделей оканчиваются на X 
(например, MTEEX, MSTEPX, MBEND90X), по которым их легко отличить от других моделей. 

Для X – моделей в электромагнитном моделировании создаётся база данных, которая 
сохраняется на диске, и затем используется в линейном моделировании. База данных представ-
ляет собой набор данных (таблицу) для ряда частотных точек. Данные для частот, лежащих 
между этими точками, в линейном моделировании получаются с помощью интерполяции. 

Электромагнитное моделирование для X – модели выполняется в N – мерной системе 
параметров. Чтобы ограничить размер базы данных, которая загружается в оперативную па-
мять, параметры модели разделены на четыре группы, описанные в следующей таблице: 

 
 Параметры  Описание 
Independed 
(Независимые) 

Параметры, которые при моделировании изменяются точно так же, как и 
параметры любого элемента схемы в линейном моделировании 

Scalable  
(Масштабируемые) 

Параметры, аналогичные независимым, которые изменяются через мас-
штабирование структуры для различных размеров 

Fixed  
(Фиксированные) 

Параметры, которые остаются постоянными для любого проекта и не из-
меняются в процессе моделирования 

Statistical  
(Статистические) 

Параметры, которые не изменяются в процессе моделирования, но могут 
обрабатываться в пределах допусков при статистическом анализе 

 
Замечание. Описание параметров, которые имеет X – модель, и группы, к которым 
они относятся, приводятся в описании соответствующей модели в каталоге элементов. 
 

Независимые параметры. 
 
В электромагнитном моделировании для изменяющихся независимых параметров соз-

даётся база данных, в которой сохраняются еще три константы, определяющие тип параметра 
(видимо определяющих, можно ли этот параметр настраивать, оптимизировать и ограничи-
вать). При создании базы данных выбирается рабочий диапазон и количество значений для ка-
ждой независимой переменной (частотные точки и значения параметров при автозаполнении 
выбираются автоматически), и для каждой выбранной точки выполняется электромагнитное 
моделирование. При линейном моделировании с использованием X – модели для всех частот, 
заданных в проекте, проверяется, попадают ли они в диапазон базы данных X - модели. Если 
заданные частоты не попадают в диапазон имеющейся базы данных, для них автоматически 
выполняется электромагнитное моделирование, и эти точки добавляются к сохраняемой на 
диске базе данных. 

Общее количество электромагнитных моделирований определяется количеством час-
тотных точек, количеством параметров и количеством их значений. Например, если задано три 
независимых параметра w1, w2 и w3 с восемью значениями для каждого параметра и задано 
десять частотных точек, то требуется 8*8*8*10=5120 электромагнитных моделирований. По-
этому число независимых параметров сводится к минимуму. 
 
Масштабируемые параметры. 

 
Масштабируемые параметры – это параметры, которые могут быть изменены без созда-

ния новой базы данных. Этот тип параметров масштабирует электромагнитную структуру так, 
что решение модели может быть связано с масштабируемым частотным решением. В результа-
те, когда таблица данных создана с содержанием масштабируемого решения, модель не должна 
создавать частное решение. Например, модель MTEEX, созданная для одной толщины подлож-
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ки, может использоваться для других толщин, если использовалось масштабирование относи-
тельно толщины подложки h. Масштабируемые параметры не увеличивают количество данных 
в базе. При наблюдении процесса автозаполнения X – модели частоты, отображаемые в окне 
процесса, могут сильно отличаться от частот, заданных в проекте, из-за частотного масштаби-
рования. 
 
Фиксированные параметры. 

 
Эти параметры не изменяются и остаются постоянными в любом проекте. Нельзя пы-

таться настраивать фиксированные параметры, т.к. это приведёт к созданию новой базы данных 
для каждого, изменённого при настройке, значения. 
 
Статистические параметры. 

 
Статистические параметры – это параметры, которые не изменяются в проекте, но мо-

гут варьироваться в пределах допусков. При создании базы данных этот тип параметра рас-
сматривается, как фиксированный. Для варьирования значения такого параметра при модели-
ровании используется зависимость первого порядка. Этот метод годится только для небольших 
отклонений от номинального значения. В случае модели микрополосковой линии единствен-
ным статистическим параметром является диэлектрическая проницаемость Er. Это могут быть 
отклонения, обусловленные частотной или температурной зависимостью диэлектрической 
проницаемости. Рекомендуются небольшие отклонения менее 10%, но статистический анализ 
нормально работает и при отклонениях менее 20%. 

1.2. Ограничения верхней частоты 
 
Реактивности неоднородности определяются запасённой энергией в структуре при от-

сутствии высших мод. Если частота приближается к частоте отсечки первой высшей моды, то 
структура уже не пригодна для проектирования микросхем обычным образом. Верхняя частота, 
до которой можно использовать такие модели, принята равной 80% от частоты отсечки первой 
высшей моды, которая возникает в неоднородности. Например, в микрополосковой линии с 
толщиной подложки, малой по сравнению с длиной волны, первая высшая мода колебаний воз-
никает при эффективной ширине самого широкого проводника, равной половине длине волны. 
Приблизительно эту частоту можно определить из выражения 

 
Fc=Z0*c/(12*H*377) 

 
где     Z0 – волновое сопротивление линии с W/H=4.0; 
 c – скорость света в выбранных единицах измерения. 
 
Верхняя частота определяется как 80% от расчётной частоты, т.е. 
 

Fmax=0.8* Z0*c/(12*H*377) 
 
Для частот выше этой максимальной частоты используется экстраполяция, основанная 

на результатах, полученных для модели. При этом пользователю выводится сообщение, указы-
вающее, что полученные результаты не основаны на электромагнитном моделировании. Обыч-
но это ограничение не нарушается при линейном моделировании и может нарушаться при не-
линейном моделировании с использованием гармонического баланса для некоторых гармоник. 

1.3. Автозаполнение X – модели 
 

Все X – модели используют таблицу данных, сгенерированную для модели на опреде-
лённой подложке. В этой таблице сохраняются результаты электромагнитного моделирования 
для определённого набора значений входных независимых переменных. При использовании 
такой модели для заданных в проекте значений переменных результаты определяются с помо-
щью интерполирования. 



Для некоторых типичных подложек эти таблицы сгенерированы фирмой AWR и вклю-
чены в пакет Microwave Office. Эти таблицы сохранены в двоичных файлах в папке 
…\EM_Models, расположенной в корневом каталоге Microwave Office. Все эти файлы имеют 
расширение .emx. Имена файлов выбираются так, чтобы по ним можно было определить назна-
чение модели. Например, MS06_00.emx означает: открытый конец микрополосковой линии 
(сокращение от Microstrip Open) на подложке с Er=6.0. Все файлы, сгенерированные в AWR, в 
имени файла содержат значение диэлектрической проницаемости. При создании нового файла 
его имя состоит из сокращённого имени модели (например, MSO для открытого конца микро-
полосковой линии) к которому добавляется три  цифры (начиная с 000), чтобы файл был уни-
кальным. 

Все X – модели имеют скрытый по умолчанию параметр AutoFill (т.е. этот параметр не 
отображается в списке параметров на схеме возле элемента). Если значение этого параметра 
равно нулю, то автозаполнение базы данных не производится и, если базы данных нет, то мо-
делирование прекращается с предложением заполнить базу данных. Если же значение парамет-
ра отлично от нуля (обычно единица), то автоматически производится заполнение базы данных, 
если она отсутствует. При желании этот параметр можно сделать видимым в списке парамет-
ров элемента следующим образом. Дважды щёлкните по элементу X – модели на схеме. В от-
крывшемся окне нажмите на кнопку Show Secondary в правом нижнем углу окна, затем на-
жмите на кнопку Display в верхней части окна, уберите галочку в столбце Hide напротив пара-
метра AutoFill и нажмите OK. 

Есть два способа заполнения интерполяционной таблицы модели на основе электромаг-
нитного моделирования. 
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В первом способе можно просто добавить X – модель в схему и начать моделирование. 
При этом способе автоматически генерируется только часть таблицы, необходимая для текуще-

го набора независимых парамет-
ров. Тем не менее, для заполнения 
этой части таблицы может потре-
боваться довольно много времени 
и процесс моделирования схемы 
может п одолжаться довольно дол-
го. Для примера на рис. 1.1 показа-
на схема проекта для моделирова-
ния соединения двух отрезков 
микрополосковых линий с учётом 
реактивности скачка. Схема состо-
ит из двух элементов MLIN с ши-
риной проводника 0.5 и 1.0 мм, 
между которыми вставлена X–
модель MSTEPX. Дважды щёлк-

ните по подложке MSUB и 
установите нужное значение 
Er (на рис.1.1 Er=10), толщину 
подложки H (на рис.1.1 H=0.5) 
и толщину проводника T (на 
рис.1.1 T=0.02). Поочерёдно, 
дважды щёлкая по элементам 
схемы MLIN, установите 
нужные параметры этих эле-
ментов (длину и ширину про-
водников), как показано на 
рис. 1.1. Дважды щёлкните по 
элементу MSTEPX и в от-
крывшемся диалоговом окне 
Element Options установите 
ширину входного и выходного 
проводников. Затем в этом же 
окне нажмите кнопку Show 
Secondary (Показать вторую), 

введите значение параметра AutoFill, равное единице (см. рис. 1.2), и нажмите OK. 

Рис. 1.1

Рис. 1.2 



Замечание. Вторая страница этого окна отличается от первой только наличием пара-
метра AutoFill. Кнопка Show Secondary в этом окне заменяется кнопкой Hide Secon-
dary (Скрыть вторую). 

 
Введите частоты проекта, дважды щёлк-

нув левой кнопкой мышки по группе Project 
Options в окне просмотра проекта, и, в открыв-
шемся окне введите начальную и конечную час-
тоты и шаг по частоте, нажмите Apply и OK. 
Создайте график, например, KstU, щелкнув по 
значку Add Graph на панели инструментов. До-
бавьте единицы измерения, щёлкнув по значку 
Add Measurement на панели инструментов, и 
выбрав Linear в окне списка Meas. Type, VSWR 
в окне списка Measurement и имя схемы в Data 
Source Name. Нажмите Apply и OK. Сделав это, 

щёлкните по значку Analyze на панели инструментов. Начнёт выполняться электромагнитное 
моделирование, ход которого будет отображаться в открывшемся окне рис. 1.3. По окончании 
моделирования будет выведен график KstU, а на диске в папке …\EM_Models появится файл 
Mss000.emx. Если теперь в проекте изменять значение диэлектрической проницаемости под-
ложки, то будут заполняться новые базы данных для этих подложек и на диске появятся файлы 
Mss001.emx, Mss002.emx, Mss003.emx и т.д. Файл Mss000.emx можно теперь переименовать, 
например, в Mss10_0.emx, где 10_0 указывает, для какой диэлектрической проницаемости под-
ложки создан этот файл. Но буквы Mss и расширение emx менять нельзя. 

Рис. 1.3 

Второй способ заключается в автозаполнении таблицы полностью. Времени для автоза-
полнения таблицы потребуется заведомо ещё больше, но этот процесс не требует вмешательст-

ва пользователя и может быть выпол-
нен в любое свободное время. 
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Замечание. Установка КЭШа более 
чем 50 Мбайт, увеличивает скорость 
электромагнитного моделирования. 
Чтобы изменить размер КЭШа, выбе-
рите Options > Environment Options 
в выпадающем меню и затем выбери-
те Cache Manager. 

 
Чтобы автозаполнить таблицу, 

нужно создать схему, включающую 
элемент, для которого нужно запол-

нить таблицу. Для примера на рис. 1.4 
показана схема для автозаполнения мо-
дели разомкнутого конца микрополос-
ковой линии (модель MOPENX), а на 
рис. 1.5 – схема для автозаполнения 
сразу двух моделей: зазора (MGAPX) и 
изгиба (MBEND90X) в микрополоско-
вой линии. В параметрах подложки ус-
тановите значение диэлектрической 
проницаемости (Er), как фиксирован-
ный параметр (т.е. постоянный для лю-
бых проектов на этой подложке). В 
схеме обязательно должны быть опре-
делены измеряемые величины (т.е. сде-
лано всё, что необходимо для проведе-
ния анализа, например, график и т.д.). 
Затем для скрытого параметра автоза-
грузки Autofill, должно быть установ-
лено не нулевое значение (обычно еди-

Рис. 1.4 

Рис. 1.5 
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ница). Обратиться к этому параметру можно, дважды щёлкнув левой кнопкой мышки по эле-
менту в схеме и затем нажав кнопку Show Secondary. 

После установки параметра Autofill в ненулевое значение, начинайте моделирование. 
Microwave Office будет заполнять таблицу для введённых номинальных параметров подложки. 
Этот процесс может быть весьма длительным и рекомендуется его выполнять в свободное вре-
мя. Во время заполнения базы данных не рекомендуется, чтобы компьютер использовался для 
других целей. 

 
Замечание. Как только начинается электромагнитное моделирование, в проекте созда-
ётся электромагнитная структура моделируемой неоднородности, которая в окне про-
смотра проекта отображается как подгруппа с именем EM_Work_Space в группе EM 
Structures. Если после начала электромагнитного моделирования остановить процесс, 
нажав кнопку Terminate Simulation в окне рис. 1.3 и затем запустить его снова, то 
можно наблюдать, как изменяется топология в процессе автозаполнения базы данных. 
Для этого дважды щёлкните по подгруппе EM_Work_Space, чтобы открыть окно элек-
тромагнитной структуры. Если затем щёлкнуть по кнопке 3D View, то можно наблю-
дать трёхмерную структуру. После этого начните процесс моделирования, щёлкнув по 
значку Analyze на панели инструментов. 
 
После заполнения таблицы в папке …\EM_Models будет создан новый emx-файл для 

данной подложки, который можно переименовать так, чтобы его имя давало больше информа-
ции о назначении файла. 

В папке …\Examples\XModels имеется пример Microstrip Autofill.emp автозаполнения 
для всех X – моделей микрополосковой линии. Этот пример представляет собой шаблон, в ко-
тором могут быть созданы базы данных для всех микрополосковых X – моделей на подложке с 
заданным значением диэлектрической проницаемости. Параметр Autofill в этом примере сделан 
видимым в списке параметров элементов и установлен равным единице. Этот шаблон упрощает 
процедуру создания проекта для автозаполнения микрополосковых X – моделей. Чтобы его ис-
пользовать: 
 

1) Загрузите этот проект из папки …\Examples\XModels и откройте окно схемы Autofill 
Microstrip, дважды щёлкнув по этой группе в окне просмотра проекта. 

2) Введите требуемые параметры подложки. 
3) Значения номинального параметра ErNom и соответствующее ему нормальное значе-

ние Er должны быть установлены одинаковыми, чтобы избежать вывода на экран пре-
дупреждения или ошибки в конце моделирования. Например, если для ErNom введено 
значение 1.23, то и для Er так же нужно ввести 1.23. 

4) Отобразите 3-х мерное изображение электромагнитной структуры, если хотите видеть 
различные структуры, которые моделируются. Для этого сначала дважды щёлкните по 
объекту EM_Work_Space в окне просмотра проекта и затем щёлкните по значку 3D 
View на панели инструментов. 

5) Выполните моделирование проекта, щёлкнув по значку Analyze на панели инструмен-
тов. 

 
Полное время заполнения базы данных для всех X – моделей микрополосковой линии 

зависит от типа компьютера и занимает, по крайней мере, 4 часа. 
Аналогичный пример-шаблон имеется и для автозаполнения всех X – моделей компла-

нарного волновода. Это пример CPW Autofill.emp в той же папке …\Examples\XModels. Ис-
пользовать этот шаблон можно точно так же, как и пример-шаблон для микрополосковой ли-
нии. Время заполнения базы данных для всех X – моделей компланарного волновода более 10 
часов. 

 
Замечание. Эксперименты с X – моделями в установленной версии Microwave Office 
2002 показали, что при обоих способах производится полное автозаполнение X - моде-
ли. 



2. Файлы данных 
 
В Microwave Office можно импортировать в проект или связывать с проектом файлы 

данных, которые являются текстовыми файлами. Файлы данных могут использоваться для раз-
личных целей. Здесь рассматриваются только файлы данных, которые можно использовать в 
схемах в качестве подсхем. Эти файлы содержат элементы матриц многополюсника (схемы, 
узла или элемента), которые получены расчётным или экспериментальным путём. 

Каждый импортированный файл данных отображается как подгруппа в группе Data 
Files в окне просмотра проек-
та с указанием имени файла 
(для импортированных фай-
лов) и пути к нему (для свя-
занных файлов), как показано 

на рис. 2.1. 
Рис. 2.1 

 
Файлы данных могут быть написаны в необработанном (row) формате или в формате 

Touchstone. 

2.1. Необработанный формат 
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Необработанный (raw) формат файлов данных используется для чтения данных из тек-
стового файла, записанных в виде строк и столбцов. Этот формат обеспечивает простой способ 

для импортирования дан-
ных из крупномасштабных 
таблиц, полученных в ма-
тематических программах 
или на измерительных ус-
тановках. Файл с необрабо
танным форматом содер-
жит только числа. В тако
файле не содержится ин-
формации о том, какой тип
матрицы он содержит, в 
какой форме представлены 
комплексные числа, каки
единицы измерения ис-
пользуются. Поэтому, как
именно должны читаться
данные из файлов с необ-
работанным форматом, 
должен определить польз
ватель в диалоговом окне 

Raw Data Format (рис. 2.1). Чтобы открыть это окно, выберите Options > Project Options в 
выпадающем меню или дважды щёлкните по группе Options > Project в окне просмотра проек-
та и затем, в открывшемся окне, нажмите на панель Raw Data Format в верхней части окна. 
Поля этого диалогового окна описаны в следующей таблице. 

Рис. 2.1 

 
Поле Описание 
Data Type 
(Тип данных) 

Определяет, какой тип данных содержит файл со свободным форматом. Можно 
выбрать S-, Y- или Z-параметры. 

Ref. Imped-
ance 
Nopm. Im-
pedance 

Если файл данных содержит S-параметры, то должен быть определён Reference 
Impedance. По умолчанию принимается значение 50 Ом, наиболее часто встре-
чающееся значение для S-параметров. 
Если файл данных содержит Y- или Z-параметры, то должен быть определён 
Normalization Impedance (нормирующий импеданс). По умолчанию его значе-
ние принимается равным 50 Ом. Для ненормированных Y- или Z-параметров 
значение Norm. Impedance должно быть 1. 
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Matrix Size 
(Размер мат-
рицы) 

Позволяет или вам самим указать число входов N-полюсника или позволить 
это сделать программе.  
Если вы сами указываете размер матрицы, то первым числом в первой строке 
файла должна быть указана частота, для которой записаны элементы первой 
матрицы. Вслед за частотой записываются элементы матрицы N-полюсника 
для этой частоты. После записи последнего элемента первой матрицы записы-
вается частота для второй матрицы, за ней элементы второй матрицы и т.д. В 
этом случае все элементы матрицы не обязательно должны находиться в одной 
строке. Также, число столбцов в различных строках не обязательно должно 
быть одинаковым и частота для каждой матрицы не обязательно должна быть в 
первом столбце. 
Если вы позволяете определить число входов программе, то все элементы мат-
риц в файле должны быть обязательно записаны в одной строке. Первым чис-
лом в каждой строке должна быть частота, для которой определена матрица. 

Format 
(Формат) 

Позволяет определить, в каком формате записаны комплексные элементы мат-
рицы. Комплексные числа из файла читаются как два вещественных числа из 
двух соседних столбцов в одной строке. Действительные данные могут читать-
ся как одно число. Могут использоваться следующие форматы данных: 
Real/Imag: x+jy, записывается как  x  y 
Mag/Angle(экспоненциальный формат): |x|*exp(j*theta), записывается как  |x|  theta 
DB и Mag/Angle: 20*log(|x|)*exp(j*theta), записывается как  20*log(|x|)  theta 
Real: x, записывается как  x 
dB: 20*log(|x|), записывается как  20*log(|x|) 

Data Order 
(Порядок 
данных) 

Определяет, как записаны элементы матрицы в файле, по строкам или по 
столбцам. 
Row Major – элементы матрицы N-полюсника записаны по строкам. Напри-
мер, для четырёхполюсника элементы S-матрицы будут прочитаны в проект в 
следующем порядке: S11, S12, S21, S22. 
Column Major – элементы матрицы N-полюсника записаны по столбцам. На-
пример, для четырёхполюсника элементы S-матрицы будут прочитаны в про-
ект в следующем порядке: S11, S21, S12, S22. 

File Units 
(Единицы 
измерения в 
файле) 

Определяет единицы измерения, которые приняты в файле данных (они могут 
отличаться от используемых в проекте). Например, если частота определена в 
Кгц, то значение частоты 10 будет преобразовано при чтении в проект как 
10.000 Гц. Единицы измерения угловых единиц используются только, если уг-
ловые единицы используются в записи элементов матриц. Для установки нуж-
ных единиц измерения используйте стрелки справа от поля ввода соответст-
вующей единицы. 

 
Обратите внимание, что все файлы данных с необработанным форматом в проекте 

должны использовать один и тот же формат, и что числа в строке должны быть отделены про-
белом или табуляцией. Следующий пример показывает типовой файл с необработанным фор-
матом для четырёхполюсника, в котором элементы комплексной матрицы записаны по строкам 
в алгебраической форме: 

 
f1 ReS11 ImS11 ReS12 ImS12 ReS21 ImS21 ReS22 ImS22 
f2 ReS11 ImS11 ReS12 ImS12 ReS21 ImS21 ReS22 ImS22 
f3 ReS11 ImS11 ReS12 ImS12 ReS21 ImS21 ReS22 ImS22 
 
Тот же пример при записи элементов матриц по столбцам имеет вид: 
 
f1 ReS11 ImS11 ReS21 ImS21 ReS12 ImS12 ReS22 ImS22 
f2 ReS11 ImS11 ReS21 ImS21 ReS12 ImS12 ReS22 ImS22 
f3 ReS11 ImS11 ReS21 ImS21 ReS12 ImS12 ReS22 ImS22 
 
В этих двух примерах число входов можно позволить определить программе.  
Если размер матрицы был определён пользователем, то первый пример может быть за-

писан, например, в следующем виде: 
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f1 ReS11 ImS11 ReS12 ImS12 ReS21 ImS21 
ReS22 ImS22 f2 ReS11 ImS11 ReS12 ImS12 
ReS21 ImS21 ReS22 ImS22 f3 ReS11 ImS11 
ReS12 ImS12 ReS21 ImS21 ReS22 ImS22 
 
При такой записи файла число входов должно быть обязательно указано пользователем 

(2 входа, т.е. четырёхполюсник). 

2. 2. Формат Touchstone 
 
Формат файла Touchstone позволяет вводить элементы G-, H-, S-, Y- или Z-матриц. В 

файле этого формата содержится вся информация о типе содержащихся в нём данных. Поэтому 
пользователю не требуется вводить какую либо информацию о типе данных, в отличие от фай-
лов с необработанным форматом. Файлы в формате Touchstone начинаются с заголовка, в кото-
ром описывается формат элементов матриц, которые записаны в этом файле. 

В любом месте файла данных можно вставлять комментарии, которым должен предше-
ствовать восклицательный знак. Комментарий сохраняется до конца строки. 

Синтаксис заголовка следующий: 
 

# HZ|KHZ|MHZ|GHZ|THZ G|H|S|Y|Z MA|DB|RI [Rx] 
 
где “|” отделяет обязательные элементы заголовка, а [ ] – не обязательный элемент. 
Каждый элемент заголовка определяется следующим образом: 
 

Элемент заголовка Описание 
# Означает начало заголовка 
HZ|KHZ|GHZ|MHZ|THZ Определяет единицы измерения частоты в файле данных (должна быть 

выбрана только одна единица) 
G|H|S|Y|Z Определяет тип матриц в файле данных (должен быть выбран только 

один) 
MA|DB|RI Определяет, в какой форме представлены комплексные переменные 

(должна быть выбрана только одна) 
[Rx] Здесь x – вещественное число, которое определяет reference impedance 

 
Примеры заголовков: 
 

# GHZ S MA R 50 
# MHZ S DB 
# HZ Z RI 

 
Синтаксис данных цепи следующий, где m – количество частотных точек, n – порядок 

матрицы: 
 

<частота 1> <строка 1> 
[<продолжение строки 1>] 
<строка 2> 
[<продолжение строки 2>] 
---------------------------------- 
<строка n> 
[<продолжение строки n>] 
<частота 2> <строка 1> 
[<продолжение строки 1>] 
<строка 2> 
[<продолжение строки 2>] 
---------------------------------- 
<строка n> 
[<продолжение строки n>] 
---------------------------------- 
<частота m> <строка 1> 
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[<продолжение строки 1>] 
<строка 2> 
[<продолжение строки 2>] 
---------------------------------- 
<строка n> 
[<продолжение строки n>] 

 
Следующий пример показывает файл данных в формате Touchstone для четырёхполюс-

ника: 
 

# GHZ S MA R 50 
! Freq         S11                     S21                    S12                     S22 
    f1  ReS11  ImS11    ReS21  ImS21    ReS12  ImS12    ReS22  ImS22 
    f2  ReS11  ImS11    ReS21  ImS21    ReS12  ImS12    ReS22  ImS22 
    f3  ReS11  ImS11    ReS21  ImS21    ReS12  ImS12    ReS22  ImS22 

 
При составлении файла в формате Touchstone необходимо соблюдать следующие пра-

вила: 
 

• Reference impedance нужно определять только для S-параметров. Если этот им-
педанс не определён, то по умолчанию принимается 50 Ом. 

• G – и H – параметры поддерживаются только для четырёхполюсников. 
• MA означает, что комплексные данные представлены в экспоненциальной фор-

ме (модуль, фаза). Фаза всегда задаётся в градусах. DB означает, что модуль вы-
ражен в децибелах по формуле 20*lg(модуля). RI означает, что комплексные 
данные представлены в алгебраической форме (действительная часть, мнимая 
часть). 

• Матрицы записываются по строкам, за исключением матриц четырёхполюсни-
ков, которые записываются по столбцам. 

• Каждый элемент матрицы – комплексное число, которое записывается как два 
вещественных числа, разделённых пробелом. 

• Каждая строка может содержать максимум четыре элемента матрицы (8 вещест-
венных чисел). Если матрица содержит более четырёх элементов, т.е. это мно-
гополюсник, то оставшиеся элементы записываются на следующей строке. 

• Каждая строка матрицы должна начинаться с новой строки. 
• На первом месте в строке матрицы должна стоять частота, для которой опреде-

лена матрица. 
• Расширением файла обычно являются g??, h??, s??, y??, z??, где знаки ? заменя-

ют любой допустимый символ. Для файла, содержащего S-матрицы, расшире-
ния могут быть s1p, s2p,…,s9p, s10, s11,…,s99. Эти расширения соответствуют 
количеству портов от 1 до 99. Например, имя файла данных в формате Touch-
stone может быть Atr20.s2p. Здесь s означает, что файл содержит S-матрицы, 2 
означает, что матрица описывает цепь с двумя портами (т.е. четырёхполюсник), 
буква p является сокращением от слова “parameters” и может быть опущена. Од-
нако расширение не используется для определения типа и размера матрицы. Все 
необходимые сведения содержатся в заголовке файла, а для определения разме-
ра матрицы из файла читается первая матрица, определяется её размер и он ис-
пользуется для остальных матриц. Это означает, что максимальный размер мат-
рицы, которая может читаться из файла, ограничивается только аппаратными 
средствами компьютера. Указанная форма расширений файлов принята только 
для удобства их систематизации пользователем. 

2. 3. Добавление файлов данных в проект 
 
Чтобы добавить файл данных в проект (т.е. импортировать файл данных): 

 
1. Если вы добавляете файл данных в необработанном формате, выберите в выпадаю-

щем меню Options > Project Options или дважды щёлкните по группе Project Options в 



окне просмотра проекта и в открывшемся диалоговом окне откройте страницу Raw Data 
Format (см. рис. 2.1). Введите требуемые значения в поля на этой странице диалогового 

окна, которые описаны 
в разделе 2.1. 
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2. Выберите Project 
>Add Data File > Im-
port Data File в выпа-
дающем меню или 
щёлкните правой кноп-
кой мышки по группе 
Data File в окне про-
смотра проекта и выбе-
рите Import Data File. 
Откроется диалоговое 
окно Открытие файла 
(рис. 2.2). 

3. Щёлкните по 
кнопке справа от поля 

Тип файлов и выберите нужный формат файла. Щёлкнув по кнопке справа от поля Пап-
ка, найдите нужный файл, выделите его в списке файлов (на рис. 2.1 это единственный 
файл atr20.s2p) и нажмите Открыть. Добавленный в проект файл данных будет отобра-
жён в окне просмотра проекта как подобъект в группе Data Files. 

Рис. 2.2

 
Чтобы вставить импортированный файл данных в схему в качестве подсхемы, откройте 

окно просмотра элементов, нажав на панель Elem в нижней части левого окна, щёлкните по 
группе Subcircuits и переместите файл данных в схему, как и любой другой элемент. Схема со 
вставленным файлом данных в качестве подсхемы (элемент SUBCKT) показана на рис. 2.3. 

 

Рис. 2.3

Замечание. Обратите 
внимание, если теперь из 
схемы удалить файл дан-
ных, то из проекта он ав-
томатически не удаляется 
и остаётся в группе Data 
Files в окне просмотра 
проекта. Чтобы удалить 
файл данных из проекта, 
щёлкните по нему в окне 
просмотра проекта пра-
вой кнопкой мышки и 
выберите Delete Data 
File. Аналогично, если 
файл данных удалить из 
проекта (из группы Data 
Files в окне просмотра), 
то из схемы он автомати-
чески не удаляется. 
 

Как только файл данных импортирован в проект, с ним можно выполнять следующие 
действия: 

 
Операция Описание 
Просмотр файла дан-
ных 

Дважды щёлкните по подобъекту файла данных в окне просмотра 
проекта. Откроется окно редактора файла (см. рис. 2.4), в котором 
можно просмотреть и отредактировать файл данных. 

Редактирование фай-
ла данных 

Текст в файле данных может быть отредактирован, используя стан-
дартные методы редактирования в Windows (выделение, копирова-
ние, вставка и т.д.). Редактор файла данных ведёт себя точно так же, 
как Блокнот Windows. 



Удалить файл дан-
ных из проекта 

Выделите подобъект файла данных в окне просмотра проекта, щёлк-
нув по нему мышкой. Затем выберите Edit > Delete в выпадающем 
меню. Или щёлкните по подобъекту файла данных в окне просмотра 
проекта правой кнопкой мышки и выберите Delete Data File в выпа-
дающем меню. 

Переименовать файл 
данных 

Щёлкните правой кнопкой мышки по подобъекту файла данных в 
окне просмотра проекта и выберите Rename Data File в выпадающем 
меню. 

Сохранить файл дан-
ных 

Файл данных можно сохранить под тем же именем или под любым 
другим. Для этого щёлкните правой кнопкой мышки по подобъекту 
файла данных в окне просмотра проекта и выберите Export Data File. 

Рис. 2.4

2.4. Связывание файла данных с проектом 
 
Вместо того чтобы файл данных добавлять к проекту, его можно связать с проектом. 

Разница в том, что при добавлении файла данных к проекту, данные из файла на диске читают-
ся в память только один раз и сохраняются в памяти, откуда они затем берутся при любом за-
пуске анализа схемы. При связывании файла с проектом, данные из файла на диске читаются 
при каждом запуске анализа. Иногда это бывает удобнее. Например, если моделируется схема, 
содержащая какое либо устройство (фильтр, смеситель или другое), которое уже изготовлено и 
элементы матрицы которого измеряются на измерительной установке. В этом случае файл дан-
ных с измерительной установки может записываться на жёсткий диск компьютера. Если этот 
файл данных связать с проектом Microwave Office, то, производя настройку устройства на из-
мерительной установке, можно наблюдать, как будет изменяться характеристика всей схемы 
проекта. 

Чтобы связать файл данных с проектом: 
 

1. Выберите Project >Add Data File > Link To Data File в выпадающем меню или 
щёлкните правой кнопкой мышки по группе Data File в окне просмотра проекта и выбе-
рите Link To Data File. Откроется диалоговое окно Открытие файла (рис. 2.2). 

2. Щёлкните по кнопке справа от поля Тип файлов и выберите нужный формат фай-
ла. Щёлкнув по кнопке справа от поля Папка, найдите нужный файл, выделите его в 
списке файлов и нажмите Открыть. Связанный с проектом файл данных будет отобра-
жён в окне просмотра проекта как подобъект в группе Data Files. 
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Замечание. Для добавленного в проект файла 
данных в окне просмотра проекта отображается 
только имя файла, а для связанного – не только 
имя, но и путь к файлу. На рис. 2.5 файл atr20 
связан с проектом, а файл atrf добавлен к проекту. Рис. 2.5  

Как только файл данных связан с проектом, с ним можно выполнять те же действия, что 
и с добавленным файлом. Кроме того, если связанный файл данных имеет необработанный 
формат, ему можно присвоить атрибут “только для чтения”. Для этого нужно щёлкнуть правой 
кнопкой мышки по подобъекту этого файла данных в окне просмотра проекта и выбрать Read 
Only во всплывающем меню. 

 
Замечания. 

1. Обратите внимание, если файл данных имеет не обработанный формат 
(raw), то перед его импортированием в проект или перед его связыванием с про-
ектом, необходимо установить нужные значения полей на странице Raw Data 
Format в диалоговом окне Project Options, как описано в разделе 2.1. 

2. Редактировать (и создавать) файлы данных можно не только в окне редакто-
ра файла данных в Microwave Office, но и в любом подходящем текстовом редак-
торе, например в Блокноте Windows или в Фотоне DOS. 
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